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法律资讯

警告提示系统

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅与财产

损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。

危险

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。

警告

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。

小心

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。

注意

表示如果不采取相应的小心措施，可能导致财产损失。

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导致人身

伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。

合格的专业人员

本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说明，特

别是其中的安全及警告提示。 由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危

险。

按规定使用 Siemens 产品

请注意下列说明：

警告

Siemens 产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前提。

必须保证允许的环境条件。必须注意相关文件中的提示。

商标

所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。若第三

方出于自身目的使用这些商标，将侵害其所有者的权利。

责任免除

我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保证印刷

品中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一版本中。

Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
德国

A5E34636659-AA
Ⓟ 10/2014 本公司保留更改的权利

Copyright © Siemens AG 2014.
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前言 1
PCS 7 SMART

PCS 7 SMART 是一个功能强大的过程控制系统，可作为过程自动化的入门之选。 即使经

验较少的用户也可以搭建自动化系统，借此易于使用的系统享受自动化技术所带来的优

势。 

PCS 7 SMART 适合于需要经济高效式自动化的公司，用于实现小型工厂配置。

本文档的用途

此文档将重点介绍 PCS 7 SMART 过程控制系统与 PCS 7 ASIA 之间的区别。

指导

除了介绍与 PCS 7 的差异外，PCS 7 SMART 文档同时还包括 PCS 7 文档的应用。这有

助于您快速访问所需的 PCS 7 功能。 可以在索引中找到重要的关键词。

访问 PCS 7 文档的方式

完整版本的文档可在“SIMATIC PCS 7 技术文档 (www.siemens.com/pcs7-
documentation)”的 Internet 页面找到。

PCS 7 SMART 自述文件（DVD 版本）

DVD 中的 PCS 7 SMART 自述文件包含了关于 PCS 7 SMART 的重要信息，并且其优先

级高于 PCS 7 SMART 提供的其它文档。 安装 PCS 7 SMART 后，可在 Windows“开始”
(Start) 菜单的以下路径下找到文档《过程控制系统 PCS 7；PCS 7 自述文件》(Process 
Control System PCS 7; PCS 7 Readme)：
“Siemens Automation > SIMATIC > 产品说明 > <语言>”(Siemens Automation > SIMATIC 
> Product Notes > <language>)

PCS 7 SMART 自述文件（Internet 版本）

Internet 上的 PCS 7 SMART 自述文件中提供的信息优先于所有 PCS 7 文档。 

请仔细阅读该 PCS 7 SMART 自述文件；其中包含有关 PCS 7 SMART 的重要信息和修

正。

PCS 7 SMART 
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Internet 上的 PCS 7 文档（最新版本）

最新版本的 PCS 7 文档可在“SIMATIC PCS 7 技术文档”的 Internet 页面找到：

● 在“SIMATIC PCS 7 软件手册 ...”部分中

– 特定 PCS 7 版本的最新系统文档和产品文档的链接。

– 最新的系统文档“PCS 7 文档门户安装程序”的下载链接。 
– 我的文档管理器 (http://support.automation.siemens.com/WW/view/zh/38715968)中

手册汇集形式的完整 PCS 7 文档的下载链接。

手册汇集包括硬件和软件手册。

所需基础知识

要理解本文档，需要具备自动化工程领域的常识和 PCS°7 的基础知识。 我们还假定读者

了解如何使用安装有 Windows 操作系统的计算机或是与 PC 类似的其它设备（如编程设

备）。 组态手册和 PCS 7 的《入门指南》文档将向您提供有关使用 PCS 7 的基本信息。

约定

在本文档中，软件界面元素的名称使用的语言被指定为与本文档的语言一致。 如果为操作

系统安装了多语言软件包，即使更改语言后，有些名称仍将以操作系统的基本语言显示。 
因此，它们与文档中所使用的名称不同。

前言

PCS 7 SMART 
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系统要求 2
2.1 硬件要求

PC 

SIMATIC IPC 347D 是针对 PCS 7 SMART 项目的定制选项。 

SIMATIC IPC 347D 拥有以下产品特性：

 组件

部件编号 6AG4012-0CA22-0BX0

芯片组 H61

处理器 Intel Core i5-3340S

RAM 4 GB

HDD 500 GB

ODD DVD±ROM

操作系统 Windows 7 Ultimate，64 位，MUI，SP1

自动化系统 

PCS 7 SMART 支持下列 CPU：

● CPU 410‑5H FW V8.1

● CPU 410 SMART FW V8.1

CPU 比较

 CPU 410 SMART CPU 410-5H

过程对象（包含） ● 100 ● 100

过程对象（最大值） ● 800 ● 2600（与 PCS 7 SMART 
一起使用时，可以使用最

多 2400 个 PO）

存储器 ● 48MB 装载

● 4MB 代码

● 4MB 数据存储器

● 48MB 装载

● 16MB 代码

● 16MB 数据存储器

PCS 7 SMART 
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 CPU 410 SMART CPU 410-5H

输入/输出 ● 1536 字节输入

● 1536 字节输出

● 16000 字节输入

● 16000 字节输出

循环时间 ● >= 200 ms ● 10 ms

功能 ● 无 F（过程安全），仅 H
● 无 SOE（时间戳 OB4x）

● HF-CPU（过程安全和冗

余）

● 时间戳和事件顺序 (SOE)
接口 ● 1x DP，最多 48 个 DP 从

站

● 无外部 DP 主站

 
● 2x PN IO 控制器，每个支

持 48 个设备或者

2x 以太网或者 
1x 以太网和 1x PN IO 控制

器

● DP 主站，最多 96 个 DP 
从站

● 最多 10x 外部 DP 主站

● 2x PN IO 控制器，每个支

持 250 个设备或者

2x 以太网或者 
1x 以太网和 1x PN IO 控制

器

防护涂层 是

组态选项 固定组件包（机架 + PS + 
CPU）

可自由配置

“STEP 7 HW 配置”中未提供其它 CPU 类型。

不可以将程序下载到其它 CPU（例如，S5、S7‑300、S7‑412/414/416/417 等）。

系统扩展卡 (SEC)

CPU 410 SMART

需要系统扩展卡来运行 CPU 410 SMART。 过程对象 (PO) 无法升级。 PO 的最大数量限

为 800，不可以增加或修改。 系统扩展卡与 CPU 410 SMART 共同构成一个硬件单元。  
在冗余使用时，必须使用两个 410 SMART CPU，并为每个 CPU 配备一个具有相同 PO 
数量的系统扩展卡。

CPU 410‑5H

需要系统扩展卡来运行 CPU 410-5H。 系统扩展卡决定了过程对象的最大可下载数量。 如
有必要，可在扩展卡所决定的值基础上使用 CPU 410 扩展包进行增加。 系统扩展卡与 
CPU 410-5H 共同构成一个硬件单元。 在冗余使用时，必须使用两个 410-5H CPU，并为

每个 CPU 配备一个具有相同 PO 数量的系统扩展卡。

系统要求

2.1 硬件要求
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2.2 已发布模块

PCS 7 SMART 不可以与 S7-400 CPU 类型一起使用。 所有同时也为 PCS 7 ASIA 发布的

其它模块都可以使用。 有关获批准模块的详细列表，请参见 SIMATIC PCS 7 系统文档 
(www.siemens.com/pcs7-documentation)中的“已发布模块”手册，该手册可在 Internet 
中的“SIMATIC PCS 7 软件手册”下找到。

说明

如果使用 CPU 410 SMART，下列限制适用：

● 不可以使用故障安全模块

● 无法使用 SOE（事件序列）功能

系统要求

2.2 已发布模块
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2.3 系统要求

操作系统

PCS 7 SMART 支持下列操作系统：

● Windows 7 SP1 x64 Enterprise

● Windows 7 SP1 x64 Ultimate

PCS 7 SMART 不支持所有其它操作系统。

PCS 7 SMART 可以扩展所有标准产品（例如，SIMATIC Process Historian、SIMATIC 
BATCH 等）。 如果这些产品要求不同的操作系统（例如，Windows Server 2008），则

在一台单独的计算机中安装标准产品。 

有关标准产品所支持的操作系统的更多信息，请参见文档 (http://
support.automation.siemens.com/CN/view/zh/98784411)下“PCS 7 SMART 在线自述文

件”手册中的“安装说明”部分。

系统组态

PCS 7 SMART 不支持客户端服务器架构。

● 下图给出了最小规模的组态示例：

说明

工程站上进行 OS 仿真

工程站上进行 OS 仿真需要 OS 运行系统许可证。

系统要求

2.3 系统要求
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● 下图给出了可能的最大规模的组态示例：

架构具有如下部分：

● 1 个 OS 单工作站系统和最多 6 个额外的参考 OS 单工作站系统 

● 1 个 OS 单工作站系统和 1 个冗余 OS 单工作站系统（单工作站系统 ＋ 备用单工作站

系统）

Internet (http://support.automation.siemens.com/WW/view/zh/24023824) 上提供了更多有

关 PCS 7 ASIA 工厂组态的更多信息。 请注意 PCS 7 ASIA 与 PCS 7 SMART 之间组态限

制的不同。

组态限制：

● 只能创建一个 OS 项目

● 同一项目在每个 OS 上运行

● 每个项目的 AS 过程对象最大数量：2400 个 PO

● 每个项目的 OS 过程对象最大数量：2400 个 PO

● 仅可使用 CPU 410-5H 和 CPU 410 SMART

● 在一个 OS 单工作站系统中，每个 Web 服务器最多同时支持 3 个 Web 客户端

● 不支持客户端/服务器

系统要求

2.3 系统要求
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PCS 7 和 PCS 7 SMART 比较 

 PCS 7 PCS 7 SMART

DVD ● ASIA ● SMART

工程软件 ● 单独提供 ● 仅在 PCS 7 SMART 组件

包中提供

语言 ● 标准 ● 英语 
● 英语和中文（简体）

许可证 ● 标准 ASIA
● ASIA USB 加密狗（仅 OS）

● ASIA 和 SMART
● SMART USB 加密狗（ES 

和 OS）
CPU ● S7-41X  

● CPU 410-5H/-SMART
● CPU 410-5H/-SMART

架构 ● 最多 18 个服务器（冗

余），

● 最多 40 个客户端，

● 最多 8 个单工作站

● 最多 1 个支持最多 6 个参

考工作站的冗余单工作站

OS 过程对象 ● 在一个 OS 服务器中，每

个 OS 项目最多 12000 个 
PO，每个单工作站系统则

最多 5000 个 PO

● 在一个 OS 单工作站系统

中，每个 OS 项目最多 
2400 个 PO

多项目 ● 标准 ● 在多项目中最多 1 个 OS 项
目

推荐 IPC ● IPC 547, 647, 847 ● IPC 347D

选择工厂中要使用的组件

有关选择系统组件的信息，请参见“SIMATIC PCS 7 系统文档 (www.siemens.com/pcs7-
documentation)”中“SIMATIC PCS 7 软件手册”下“PCS 7 工程系统”手册的“PCS 7 工
厂组件”部分。

系统要求

2.3 系统要求
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2.4 安装

语言组合 

PCS 7 SMART 安装程序提供以下语言组态：

系统语言 在 PCS 7 安装程序中

选择用户界面语言

PCS 7 SMART 可用的语

言

已安装的库的语言

中文

（简体）

英语 英语（默认）

中文（可选）

英语

中文

（简体）

中文

（简体）

英语（默认）

中文（默认）

中文

（简体）

英语 英语 英语

（默认）

英语

PCS 7 SMART 的安装

启动安装盘中的文件 Setup.exe 并按照说明进行操作。

系统要求

2.4 安装
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许可证 3
PCS 7 SMART 组件包的交付范围

下面概要介绍了 PCS 7 SMART 的可用组件包。 “✓”符号后面的括号中包含所包含组件的

数量。 组件包名称后面的括号则包含组件包的部件编号。

软件包名称 →
组件

↓
 
 
 

标准组件包 (6ES7650-6BB18-0XX0)
 冗余组件包 (6ES7650-6BB18-0XX1)

 标准包组件包，无 IPC (6ES7650-6AB18-0XX0)
 冗余组件包，无 IPC (6ES7650-6AB18-0XX1)

  标准组件包，带 CPU 410‑5H
(6ES7650-6BA18-0XX0)
 冗余组件包，带 

CPU 410‑5H
(6ES7650-6BA18-0XX1
)

IPC 347D1 ✓ (1) ✓ (3)   ✓ (1) ✓ (3)

CPU 410 SMART 组件包 ✓ (1)2 ✓ (2)2 ✓ (1)2 ✓ (2)3   

CPU 410 组件包 4     ✓ (1)  

CPU 410 冗余组件包 5      ✓ (1)

IM PA SMART ✓ (1) ✓ (2) ✓ (1) ✓ (2) ✓ (1) ✓ (2)

SoftNet RedConnect6 ✓ (1) ✓ (2) ✓ (1) ✓ (2) ✓ (1) ✓ (2)

PCS 7 V8.1 软件介质包 
SMART7

✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1)

PCS 7 V8.1 AS/OS 工程

组态 SMART（PO 不
限） 

✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1)

PCS 7 运行系统许可证 
AS 
(PO 100)

✓ (1) ✓ (1) ✓ (1) ✓ (1)   

PCS 7 SMART 
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软件包名称 →
组件

↓
 
 
 

标准组件包 (6ES7650-6BB18-0XX0)
 冗余组件包 (6ES7650-6BB18-0XX1)

 标准包组件包，无 IPC (6ES7650-6AB18-0XX0)
 冗余组件包，无 IPC (6ES7650-6AB18-0XX1)

  标准组件包，带 CPU 410‑5H
(6ES7650-6BA18-0XX0)
 冗余组件包，带 

CPU 410‑5H
(6ES7650-6BA18-0XX1
)

PCS 7 V8.1 OS 单工作

站 SMART (PO 100)
✓ (1)  ✓ (1)  ✓ (1)  

PCS 7 V8.1 OS 单工作站

冗余 SMART
(2x OS RT PO 100)

 ✓ (1)  ✓ (1)  ✓ (1)

1 预装 Win7 64 位 Ultimate 版本
2 包括 UC PS 4A + 4 插槽机架
3 包括 2xPS 4A + 2x4 插槽机架和 2x 同步电缆和模块
4 包括 UC PS 4A + 4 插槽机架；IL RT 许可证；AS RT PO 100 许可证
5 包括 2x UC PS 4A + 2x 4 插槽机架；1x 同步电缆和模块；1x IL RT 许可证；1x AS RT 
PO 100 许可证
6 8x 单/4x 冗余连接
7 PCS 7 SMART 所需的所有其它许可证均为 PCS 7 ASIA 许可证。

说明

下列产品为 PCS 7 SMART 组件包内的专有产品，并且不可单独购买：

● PCS 7 V8.1 AS/OS 工程组态 SMART（PO 不限）  
● PCS 7 V8.1 OS 单工作站冗余 SMART (2x OS RT PO 100)
产品“PCS 7 OS 单工作站 SMART (PO 100)”（部件编号 6ES7658-2AA18-5CA0）可单

独订购，以便通过附加 OS 单工作站系统扩展工厂。

许可证

PCS 7 SMART 
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通过控制系统组件扩展 PCS 7 SMART 

PCS 7 SMART  的功能可以扩展（例如，SIMATIC BATCH、SIMATIC Route Control、
WebServer、Process Historian、Information Server 或 Import‑Export Assistent）。 单独

的许可证可用于升级其它功能。 有关控制系统组件的概览，可通过产品目录搜索 (http://
w3app.siemens.com/mcms/infocenter/content/zh/Pages/order_form.aspx?
nodeKey=key_516907&infotype=1&linkit=null)查找“SIMATIC PCS 7 标准产品目录 ST 
PCS 7”目录。

14 天试用模式 

PCS 7 SMART 不包括 14 天试用模式。

PCS 7 SMART OS 演示模式

PCS 7 SMART 在以下情形时转换为演示模式：

● 当超出 OS 过程对象的最大数量（2400 个 PO）时

● 当缺少许可证时

● 当缺少 USB 加密狗时

演示模式会在以下方面限制 PCS 7 SMART 的使用：

● 在演示模式中，WinCC 项目管理器和编辑器会在 60 分钟后自动结束。

● 在 PCS 7 SMART OS 运行系统中，通知窗口每隔一段时间弹出表示演示模式正在运

行；窗口必须确认。

USB 加密狗 

PCS 7 SMART 的 USB 加密狗仅旨在用于 PCS 7 SMART。 确认将 USB 加密狗永久性地

插入到相关 PCS 7 SMART 版本所在计算机的 USB 端口中。 如果在运行期间拔出 USB 
加密狗，PCS 7 SMART 将转为演示模式。 

要避免丢失 USB 加密狗，关闭并锁上 IPC 的前面板。

许可证
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从 PCS 7 SMART 到 PCS 7 ASIA 的许可证升级

无法进行从 PCS 7 SMART 至 PCS 7 ASIA 的许可证升级。 如要使用 PCS 7 ASIA，必须

购买相应的标准许可证：

PCS 7 SMART V8.1 PCS 7 V8.1 ASIA 订货号

AS/OS 工程组态 SMART AS/OS 工程组态 ASIA 6ES7658-5AX18-0CA5

OS 单工作站 SMART OS 单工作站 SN ASIA 6ES7658-2AA18-6CA0

OS 单工作站冗余 SMART OS 单工作站冗余 SN ASIA 6ES7652-3AA18-6CA0

说明

其它所有许可证均为标准许可证，并且不可替换。

将 PCS 7 SMART 更新到新的 PCS 7 SMART 版本

只要具有新版本的 PCS 7 SMART，就可以进行更新。

过程对象 (PO) 的数量限制 

过程对象分为 OS PO（操作员站的过程对象）和 AS PO（自动系统的过程对象）。

每个 PCS 7 SMART 组件包带有 100 个 OS PO。要增加 PO 的数量，可以使用许可证软

件包进行升级。 每个 OS 单工作站系统或者每个 PCS 7 SMART 项目的最大过程对象 (PO) 
数量限制为 2400 个。

当使用的 PO 数量超过 2400 的限制时，将发生下列情况：

● AS： 不可进行 AS-OS 传输

● OS：通知窗口弹出，并且 OS 转为演示模式

过程对象 (PO)

以下几点适用于过程对象“PO”的许可：

许可证
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可作为 PCS 7 过程对象的如下： 

● 所有 SFC

● 所有符合以下标准的块实例：

– 可控制和监视的实例。

– 实例将生成报警。

– 实例不属于驱动程序库。

这些对象将传送到 OS，并且必须进行许可。 
对于能够控制和监视的块，其在 CFC 块属性 (property) 中的属性 (attribute) "S7_m_c 
= true"。

过程对象可以包括下列块和对象中的一个：

● 操作和监视系统的块

● 用于实现自动化的对象

● 用于信号记录和信号处理的对象

有关过程对象的更多信息，请参见文档 (www.siemens.com/pcs7-documentation)下
“SIMATIC PCS 7 软件手册”下“许可证和组态限制”手册的“自述文件和许可证”部

分。 

可用的许可证软件包（PO 许可证）

对于 PCS 7 SMART，未提供专门的 PO 许可证。 如要扩展 PCS 7 SMART 中过程对象的

数量，可使用 PCS 7 适用的 PO 许可证。

许可证

PCS 7 SMART 
设备手册, 09/2014, A5E34636659-AA 19

http://www.siemens.com/pcs7-documentation


你可以从下列 PCS 7 许可证中选择：

过程控制系统组件 许可证等级 注释

操作站 (OS) PO：

● 100
● 1000

许可证密钥“OS RT PO”
● 单工作站系统： 最多 2400 个 

PO

使用操作员站归档 归档值:
● 1500
● 5000
● 10000
● 30000

每秒可归档的最大归档值数

对于 OS 单工作站系统：500

工程组态系统 (ES) 下载

SIMATIC
站

PO：

● 100
● 1000
● 10000

许可证密钥“AS RT PO”
● 下载到 AS 时需要，但测试或 

S7 PLC 仿真不需要。

● 对于冗余系统，只需要一次。

说明

可使用此处所列的许可证包扩展 100 个预安装的 PO 许可证。

CPU 410 SMART 最多可使用 800 个 PO。

CPU 410-5H 最多可使用 2600 个 PO（与 PCS 7 SMART 配合使用时，最多可使用 2400 
个 PO）。

有关 CPU 410‑5H 的详细信息，请参见“SIMATIC PCS 7 硬件手册”下的“PCS 7 CPU 
410-5H 过程自动化”手册 (www.siemens.com/pcs7-documentation)。
有关 CPU 410 SMART 的详细信息，请参见《PCS 7 过程控制系统 CPU 410-5H 过程自

动化/CPU 410 SMART》(PCS 7 Process Control System CPU 410-5H Process 
Automation/CPU 410 SMART) 手册 (http://support.automation.siemens.com/WW/view/
zh/82142878)。

许可证
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PCS 7 SMART 和 PCS 7 ASIA 之间的差异 4
4.1 差异概述

PCS 7 SMART 具有以下属性： 

属性 对 PCS 7 SMART 的影响

简化的界面 可获得更好的总览并简化操作

限制过程对象 最多可使用 2400 个 PO

不支持 VBA 不支持对大量数据进行工程组态

限制归档周期 每秒最多 500 个值

限制 OS 通道 仅限“命名的连接”(PA CPU)+OPC UA/DA/A&E/
HAD（第三方）+ProfiBus

限制项目设置 仅限单工作站项目

无服务器数据 只支持单工作站，不支持服务器

无块列表编辑器 只读；无法编辑

无 WinCC 
CrossReferenceAssistant

无其它总览可用

限制 PCS 7 项目向导 ● 只能选择 CPU 410-5H 和 CPU 410 SMART
● 仅限单工作站项目

限制文本库 ● 只支持英文和中文（简体）

● 只读；无法编辑

文本分配器 不支持文本分配器。

限制支持的 CPU 只支持 CPU 410-5H 和 CPU 410 SMART

限制 WinCC 对象管理器 ● 不支持客户端/服务器

● 最多支持 8 个单工作站

限制 OS 项目编辑器 ● 最多支持两个监视器

● 仅限“单工作站项目”

限制通信 仅支持 S7 连接

仅包中的 ES 许可证可用 协调软件包
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属性 对 PCS 7 SMART 的影响

仅包中的 SoftNet RedCon 
SMART 可用

协调软件包

CFC CPU 和许可证 仅支持 PA‑CPU；需要 CFC‑SMART 许可证和加密

狗

PCS 7 SMART 和 PCS 7 ASIA 之间的差异

4.1 差异概述
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4.2 过程对象

每个 OS 单工作站系统或每个 PCS 7 SMART 项目的过程对象 (PO) 数量限制为 2400 个。

如果使用的 PO 数超过 2400 个 PO 的限制，将收到警告消息。 

使用 PCS 7 许可证包进行升级，可将可用的 PO 数量增加到最多 2400 个。 特殊的 
PCS 7 SMART 许可证包不可用。 使用可用于 PCS 7 的许可证包。

说明

可用过程对象的数量还取决于所用的 CPU。 有关 CPU 过程对象的信息，请参见系统要

求 (页 7)部分。

PCS 7 SMART 和 PCS 7 ASIA 之间的差异

4.2 过程对象
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4.3 ES 功能

多项目 

下面的特殊注意事项适用于 PCS 7 SMART 中的多项目：

● 只能创建一个 OS 项目。

AS-OS 工程组态 

PCS 7 SMART 在向 OS (WinCC) 传输数据期间会检查过程对象的数量。 如果该数量多

于 2400 个，会取消数据传输，并显示错误消息。 

在这种情况下，请减少组态的过程对象数量，然后再次传输数据。

ES 和 OS 之间可能的连接类型 

可以在 NetPro 中通过以下方式组态 ES 和 ES 之间的连接：

● S7 通道

– 命名的连接（用于 CPU 410‑5H 和 CPU 410 SMART）
– PROFIBUS

● 所有 OPC 通道（只能在 OS 上使用，不能在 ES 和 OS 之间使用）

在 AS 和 OS 之间进行传输时，将终止任何其它连接并给出错误消息。

PCS 7 SMART 项目向导 

PCS 7 项目向导在项目创建期间为您提供支持。 与 PCS 7 中的项目向导相比，该向导具

有以下限制：

● 只能选择 CPU 410-5H 或 CPU 410 SMART。

● 只能创建单工作站项目。

PCS 7 SMART 和 PCS 7 ASIA 之间的差异

4.3 ES 功能
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4.4 STEP 7

4.4.1 STEP 7 - 用户界面

在 PCS 7 SMART 用户界面中禁用以下功能，这就意味着不显示或灰显这些功能：

软件产品 菜单命令

SIMATIC Manager ● 文件 > S7 存储卡 (File > S7 memory card)
● PLC > 管理 M7 系统 (PLC > Manage M7 system)
● PLC > 将 RAM 复制到 ROM (PLC > Copy RAM 

to ROM)
● 插入 > 站 > SIMATIC-300 站 (Insert > Station > 

SIMATIC-300 station)
● 插入 > 站 > SIMATIC S5 (Insert > Station > 

SIMATIC S5)
● 编辑 > 项目属性 (Edit > Project properties) → 

“类型”(Type) 区域中的对话框 - 无法选择

“STEP 7”选项

● 选项 > CAx 数据 (Options > CAx data)

HardwareConfig ● 站 > 导入 (Station > Import)
● PLC > 上传 (PLC > Upload)

NetPro ● 编辑 > 导入 (Edit > Import)

4.4.2 STEP 7 - 功能

命令界面 

命令界面不可用。

PCS 7 SMART 和 PCS 7 ASIA 之间的差异

4.4 STEP 7
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4.5 OS (WinCC)

4.5.1 OS (WinCC) - 用户界面

以下功能在 PCS 7 SMART 中具有不同的功能。

功能 限制

服务器数据 不支持服务器数据，因为 PCS 7 SMART 没有任何

客户端/服务器体系架构。

文本库 可以以只读方式打开文本库。 无法编辑

内容。

文本分配器 不支持文本分配器。

WinCC 
CrossReferenceAssistan
t

不支持 WinCC CrossReferenceAssistant。

块列表编辑器 块列表编辑器只支持读访问。 
无法编辑内容。

OS 项目编辑器 ● 画面设置

OS 项目编辑器的视图限制为最多两个画面。

● 项目设置

PCS 7 SMART 只支持单工作站项目。 这意味着无法更改

到其它项目类型（例如，多用户项目）。

4.5.2 OS (WinCC) - 功能

大量数据工程组态 

无法在图形编辑器中通过 VBA 实现大量数据工程组态。 可以在过程画面中无限制地使用

脚本语言 VBS 和 ANSI-C。

归档过程数据 

每个 OS 单工作站系统的归档值数量不应超过每秒 500 个值。

PCS 7 SMART 和 PCS 7 ASIA 之间的差异

4.5 OS (WinCC)
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OS 接口 

在 OS 项目编辑器中可以使用以下接口：

连接名称 应用领域

S7 通道：

● 命名的连接

● PROFIBUS

 
● 用于 CPU 410-5H 和 CPU 410 SMART

所有 OPC 通道（UA、DA、A&E、HDA）  

WinCC Sysinfo 通道  

所有其它接口均不支持。

Web 客户端

PCS 7 SMART 最多支持三个 web 客户端。

脚本编辑器

只能以只读方式打开全局脚本。 无法更改全局脚本。

4.5.3 OS (WinCC) - 支持的硬件

画面 

PCS 7 SMART 的每个 OS 最多支持使用两个画面。 可以在 OS 项目编辑器的菜单中访问

画面设置。

PCS 7 SMART 和 PCS 7 ASIA 之间的差异
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PCS 7 SMART 和 PCS 7 ASIA 之间的差异

4.5 OS (WinCC)

PCS 7 SMART 
28 设备手册, 09/2014, A5E34636659-AA



硬件目录 5
硬件目录 

PCS 7 SMART 支持所有 PCS 7 支持的 I/O 设备。 

下表列出了 PA SMART 产品：

产品名称 说明 部件编号

DI32 ET 200PA SMART 模块 650-8DK80-0AA0

DI32-coated ET 200PA SMART 模块 650-8DK80-1AA0

DI16 Diag ET 200PA SMART 模块 650-8DK70-0AA0

DI16 Diag- coated ET 200PA SMART 模块 650-8DK70-1AA0

DO32 ET 200PA SMART 模块 650-8EK80-0AA0

DO32- coated ET 200PA SMART 模块 650-8EK80-1AA0

DO16 Diag ET 200PA SMART 模块 650-8EK70-0AA0

DO16 Diag- coated ET 200PA SMART 模块 650-8EK70-1AA0

AI8 Diag ET 200PA SMART 模块 650-8AK60-0AA0

AI8 Diag- coated ET 200PA SMART 模块 650-8AK60-1AA0

AI16 Diag ET 200PA SMART 模块 650-8AK70-0AA0

AI16 Diag- coated ET 200PA SMART 模块 650-8AK70-1AA0

AI TC/RTD ET 200PA SMART 模块 650-8AR60-0AA0

AI TC/RTD- coated ET 200PA SMART 模块 650-8AR60-1AA0

AO8 Diag ET 200PA SMART 模块 650-8BK60-0AA0

AO8 Diag- coated ET 200PA SMART 模块 650-8BK60-1AA0

IM153 ET 200PA SMART 模块 650-8PH00-0AA0

IM153- coated ET 200PA SMART 模块 650-8PH00-1AA0

RWB PS-IM ET 200PA SMART 模块 650-8PA00-0AA0

RWB PS-IM- coated ET 200PA SMART 模块 650-8PA00-1AA0

RWB IM-IM ET 200PA SMART 模块 650-8PB00-0AA0

RWB IM-IM- coated ET 200PA SMART 模块 650-8PB00-1AA0

RWB IO-IO ET 200PA SMART 模块 650-8PC00-0AA0

PCS 7 SMART 
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产品名称 说明 部件编号

RWB IO-IO- coated ET 200PA SMART 模块 650-8PC00-1AA0

CPU 410 SMART 接口： 
● PROFIBUS DP
● 2x2 端口 PROFInet
工作存储器（7.5 ns SMART 
卡）： 
● 最大 8 MB

6ES7 410-5HN08-0AB0

硬件目录
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从 PCS 7 SMART 切换至 PCS 7 ASIA 6
6.1 安装 PCS 7 ASIA

可通过 PCS 7 ASIA 的安装程序可扩展安装 PCS 7 SMART 到 PCS 7 ASIA，且无需卸载 
PCS 7 ASIA。

说明

从 PCS 7 SMART 进行更改前，将所需项目保存为归档以便移植到 PCS 7 ASIA 中。

说明

升级前，关闭所有不需要的程序，然后重启计算机。

按照以下步骤从 PCS 7 SMART 升级到 PCS 7 ASIA。

1. 将 PCS 7 ASIA 的安装数据存储介质“DVD 1”插入 PC 的 DVD 驱动器。

2. 启动“Setup.exe”文件。
将启动安装向导。

3. 为安装向导选择所需的语言。
可以在英文和中文之间选择。

4. 单击“下一步 >”(Next >)。
将显示包含有关执行安装信息的对话框。

5. 单击“下一步 >”(Next >)。
将显示有关产品信息的对话框。 可在此处显示有关 PCS 7 的信息。 

6. 单击“是，我想阅读这些说明”(Yes, I would like to read the notes) 来显示信息。
单击“下一步 >”(Next >) 继续安装。
安装向导会分析已安装的 PCS 7 SMART。 分析可能需要几分钟的时间。 请等待分析结束。
随后会显示包含许可证协议的对话框。

7. 激活复选框“我接收这些条件...”(I accept the conditions...) 来接收许可证协议。

PCS 7 SMART 
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8. 单击“下一步 >”(Next >)。
将显示包含安装方法信息的对话框。

9. 激活选项按钮“安装”(Install) 继续进行从 PCS 7 SMART 到 PCS 7 ASIA 的升级。

说明

选择“安装”(Install) 是因为该过程涉及从 PCS 7 SMART 到 PCS 7 ASIA 的新安装。 
选择“更新”(Update) 只是将现有产品更新到更高的版本号，但不会扩展功能。

10.单击“下一步 >”(Next >) 按钮。
将显示用户信息对话框。

11.分配用户和公司名称。

12.单击“下一步 >”(Next >) 按钮。
将打开用于选择 PCS 7 中的语言的对话框。
可以在英文或中文之间进行选择。 如果选择了“英文”安装向导，则“英文”和“中文”
语言为默认设置，且无法更改。 如果选择了“中文”安装向导，则“中文”语言为固定的
默认设置，“英文”可作为选项进行选择。

从 PCS 7 SMART 切换至 PCS 7 ASIA
6.1 安装 PCS 7 ASIA
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13.单击“下一步 >”(Next >) 按钮。
将打开包含安装类型信息的对话框。

14.选择安装类型。
激活选项按钮“软件包安装”(Package installation) 可使用软件包选择安装范围。
激活选项按钮“用户自定义安装”(User-defined installation) 可使用单独的产品来选择安装范
围。
此处选择“软件包安装”(Package installation)。
安装路径显示在“目标目录”(Target directory) 部分。

从 PCS 7 SMART 切换至 PCS 7 ASIA
6.1 安装 PCS 7 ASIA
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15.单击“下一步 >”(Next >) 按钮。
将显示包含可选“程序包”的对话框。

16.通过激活相关复选框选择所需的“程序包”。 
要支持所有项目功能，至少应选择在 PCS 7 SMART 中也会使用的软件包。

从 PCS 7 SMART 切换至 PCS 7 ASIA
6.1 安装 PCS 7 ASIA
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17.单击“下一步 >”(Next >) 按钮。
将显示包含可选程序的对话框。 

仅显示包含在之前所选的“程序包”中的那些程序。
条目前可能会显示蓝色符号：

– 蓝色复选标记：程序已安装在系统上。

– 蓝色通知符号：安装前必须满足另一要求。 通过激活相应的复选框，会显示有关要

求的详细信息。

– 无蓝色符号：可安装程序。

说明

选择一个组件后，可能会激活其附加组件。 在这种情况下，所选的组件需要自动选

择的组件以正常运行。 

18.单击“下一步 >”(Next >) 按钮。
将显示一个对话框，其中汇总了将在安装期间执行的自动化系统更改。
如果同意进行这些更改，则激活复选框“我接受对系统设置的更改”(I accept the change to 
the system settings)。

19.单击“下一步 >”(Next >) 按钮。
将显示一个对话框，其中汇总了要安装的组件、所需的存储空间和大约的安装持续时间。

20.如果要启动安装，单击“安装”(Install) 按钮。
将显示包含各安装步骤和当前进度的对话框。
可能会显示指示需要重启的对话框。
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21.单击“确定”(OK) 按钮执行重启。
随后系统会重新启动。 重启后会自动继续安装。
随后将显示指示成功安装的对话框。

22.单击“完成”(Finish)。
完成从 PCS 7 SMART 到 PCS 7 ASIA 的升级。

说明

有关许可 PCS 7 ASIA 版本的信息，请参见 Internet (www.siemens.com/pcs7-
documentation) 上“SIMATIC PCS 7 软件手册”下的“许可证和组态限制”手册。
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6.2 移植项目

下文将介绍如何将 PCS 7 SMART 项目移植到 PCS 7 ASIA 中。

说明

只能通过 SIMATIC manager 移植项目。 移植期间始终移植整个项目。

从 PCS 7 SMART 移植到 PCS 7 ASIA 后，只能在 PCS 7 ASIA 中打开项目。 项目移植

后，无法撤销移植。 到 PCS 7 ASIA 的移植将提升与 PCS 7 SMART 相关的限制。

从 PCS 7 SMART 到 PCS 7 ASIA 的移植 

已归档项目的归档将采用 zip 文件的形式执行移植。

说明

执行到 PCS 7 ASIA 的升级前，归档所需的项目。

移植项目归档时，会保留原始归档数据，可在其它 PCS 7 SMART 系统上使用这些数据。

移植项目归档

要求：

已对 PCS 7 SMART 项目进行归档，且可以通过 PCS 7 ASIA 访问此文件。

1. 启动 SIMATIC Manager。

2. 选择菜单命令“文件 > 重新获取...”(File  > Retrieve)。
将打开“重新获取”(Retrieve) 对话框。

3. 在文件系统中选择项目归档（zip 文件）。

4. 单击“打开”(Open)。
将打开“选择目标目录”(Select destination directory) 对话框。

5. 在文件系统中，选择用于解压缩项目文件的文件夹。
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6. 单击“确定”(OK) 按钮。
将打开“重新获取”(Retrieve) 对话框。

说明

此对话框指示 PCS 7 SMART 格式的项目文件将转换为 PCS 7 ASIA 格式。

此归档文件保持不变。 只将未解压缩的项目文件移植为 PCS 7 ASIA 格式。

7. 如果同意，单击“确定”(Yes) 按钮。
项目将转换为 PCS 7 ASIA 格式并保存在所选文件夹中。
将打开“重新获取”(Retrieve) 对话框，确认项目文件的移植。

8. 单击“确定”(OK) 按钮。
完成移植。 
现在，可以在 PCS 7 ASIA 中打开该项目。
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